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Chapter 1: Getting Started

Welcome
Welcome to Eye Candy 5: Nature 
(Nature), a set of 10 plug-in effects 
for Photoshop and other compatible 
graphics host programs.

This chapter explains how to install 
your software and provides an 
overview of the features common to 
each filter. In this chapter, you’ll find 
the following sections:

• What’s New

• Eye Candy 5 Release Schedule

• Host Requirements

• System Requirements

• Macintosh Installation

• Windows Installation

• User Interface

• Keyboard Shortcuts

What’s New
This section lists the new filters, 
features and improvements included 
in Nature.

New Filters
Nature adds four new effects to the 
Eye Candy family of filters:

• Icicles

• Rust

• Ripples

• Snow Drift

Interface Improvements
Several interface improvements 
appear in the Eye Candy 5 series:

• Improved Settings manage-
ment—settings are now accessed 
under the Settings tab. You can 
create, manage, save, share and 
backup settings. See the Using 
Settings section for more details.

• UpToDate—a messaging system 
we will use to communicate with 
our users. See the UpToDate 
Messages section for more 
details.

• Intra-product navigation—switch 
from one Eye Candy 5 filter set to 
another from within the Nature 
user interface.

Changes to Existing 
Filters
Besides the aforementioned user 
interface changes and new filters, Eye 
Candy veterans will notice the 
following updates to pre-existing 
filters:
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• Corona—Corona can create a 
new layer in Photoshop, then 
apply the effect there. We’ve also 
added a Photoshop style gradient 
editor so you can recreate perfect 
solar flares.

• Drip—Melt and drip have been 
combined. They were so compli-
mentary, we figured you were 
wasting your time jumping from 
filter to filter. 

• Fire—Fire has an all-new photo-
realistic look. This one gets the 
gradient editor, and new layer 
features too. 

• Smoke—Smoke has also been 
rewritten for a brand-new look 
and more versatility. Like Fire, 
you can apply smoke to its own 
layer from the filter itself.

• Squint—Squint has new streak-
ing features to imitate light 
refracted by water and more.

• Water Drops—Water drops is 
much more realistic. Drops pool 
together more naturally and the 
lighting tools have improved. 

UpToDate Messages
The UpToDate messaging system 
keeps you informed about the latest 
Alien Skin Software products, special 
offers, software updates and other 
news. 

When you receive a message, an 
unobtrusive visual cue announces, 

“Click here for new messages from 
Alien Skin Software.” Click this link to 
read your new messages. See the 
interface example below:

Customizing UpToDate 
Preferences
Receiving messages is optional. You 
can specify the intervals at which your 
UpToDate system checks for 
messages. To customize your 
UpToDate message preferences, use 
the following instructions:

1. In any filter, Click Edit > 
Preferences .

2. Select the frequency at which you 
would like the UpToDate system 
to check for new messages. If you 
don’t want to receive messages, 
select Never.

Windows users: If you have a dial-
up Internet connection, you should 
select the Ask me before making 
an Internet connection option. If 
not, your computer will make 
unexpected phone calls.

Macintosh users: If you have a 
dial-up Internet connection, deselect 
the Ask me before making an 
Internet connection option. You 
must establish an Internet connection 
before receiving UpToDate messages.
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Seamless Tiling
Some filters feature a seamless tiling 
option. Seamless tiles are rectangular 
images that fit together like a puzzle 
when lined up next to each other.

Note: Seamless tiles should only be 
used for specialized jobs, such as 
desktop wallpaper, Web backgrounds 
or 3-D graphics. Don’t use this 
feature unless you have to.

To get the best results when creating 
seamless tiles, you should follow a 
few simple guidelines:

• Always create seamless tiles in 
rectangular selections. 

• Don’t use tiny tiles. Small tiles 
create obvious repetitive pat-
terns.

• If you intend to use seamless til-
ing, select the Seamless Tile 
option before  you tweak the 
effect. If you don’t, the filter may 
need to stretch the texture dispro-
portionately.

Eye Candy 5 
Release Schedule
Eye Candy 5 is being upgraded in 
three collections. Textures was the first 
and Nature is the second set in the 
series. Each set contains 10 filters. 
The final upgrade to Eye Candy 5, 
Impact, will be released by the 
summer of 2005. 

Host Requirements
This is a plug-in; you must use it with 
a compatible host program.

Macintosh Hosts

Adobe Photoshop 7 or later

Adobe Photoshop Elements 2 or later

Macromedia Fireworks MX 2004 or 
later

Windows Hosts

Adobe Photoshop 7 or later

Adobe Photoshop Elements 2 or later

Macromedia Fireworks MX 2004 or 
later

Jasc Paint Shop Pro 8 or later

System 
Requirements
Macintosh Systems

• 500 MHz PowerPC G3 processor

• 256 MB RAM

• Mac OS X 10.2.6 or later

Windows Systems

• 1 GHz Pentium III processor

• 256 MB RAM

• Windows 2000 or Windows XP
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Macintosh 
Installation
Use the following instructions to install 
Nature:

1. Shut down your graphics host 
program (Photoshop, Fireworks, 
or Elements).

Note: To install Nature, your OS 
X user account must have 
administrator privileges. For 
information on configuring your 
user account for administrator 
privileges, talk to your IT guy or 
consult your OS X user manual.

2. Insert the Nature CD into your 
computer. If you purchased an 
electronic version of Nature, 
locate the Nature installation 
program that you downloaded 
from the online store. 

3. Double-click the Install Nature 
icon.

4. Click Continue. 

5. Read the License Agreement.

6. Click Accept.

7. Enter your name, company name 
(optional) and your registration 
code.

Note: The registration code is a 
12-letter sequence inside the 
front cover of your manual. 

If you purchased an electronic 
version of Nature, you’ll find the 

12-letter code in the e-mail 
invoice, sent with your 
downloaded software. Store this 
e-mail in a safe place for future 
installations.

8. Click Register.

Our installer will now search for 
Photoshop 7, CS, Elements or 
Fireworks MX 2004. 

9. Photoshop users:  Highlight 
<Drive> / Applications / 
Adobe Photoshop (7 or CS) 
/ Plug-ins and click OK to 
install Nature. The installer will 
find the Photoshop plug-ins 
folder and install Nature there.

Elements users: Highlight 
<Drive> / Applications / 
Adobe Photoshop Elements 
2 / Plug-ins  and click OK to 
install Nature. The installer will 
find the Photoshop plug-ins 
folder and install Nature there.

Fireworks MX 2004 users:  
Highlight <Drive> / 
Applications / Macromedia 
Fireworks MX 2004 / Plug-
ins and click OK to install 
Nature. The installer will find the 
Photoshop plug-ins folder and 
install Nature there.

Photoshop users can check for 
the plug-in location by selecting 
the Plug-In option under the 
Preferences  sub-menu of 
Photoshop’s Edit menu.
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If the installer does not 
find the plug-ins folder: 
Click the Choose another 
install location  button.

Locate your plug-in folder. If you 
do not choose the proper folder, 
the filters will not show up in your 
Filters  menu.

Note: If you are not sure where 
to install Nature, consult your 
graphics program user manual. 

10. Highlight the folder and click the 
Choose button to return to the 
main installation screen. The 
installer copies the files to your 
hard disk.

Rerun the installer if you wish to 
install Nature into other graphics 
programs.

Windows Installation
Use the following instructions to install 
Nature:

1. Shut down your graphics host 
program (Photoshop, Fireworks, 
Elements or Paint Shop Pro).

Note: To install Nature, your 
Windows 2000 or XP user 
account must have administrator 
privileges. For information on 
configuring your user account for 
administrator privileges, talk to 
your IT guy or consult your user 
manual. 

2. Insert the Nature CD into your 
computer. If you purchased an 
electronic version of Nature, 
locate the installation program 
that you downloaded from the 
online store. 

3. Double-click the Setup.exe  
icon.

4. Click Next. 

5. Read the License Agreement.

6. Click Accept.

7. Enter your name, company name 
(optional) and your registration 
code.

Note:  The registration code is a 
12-letter sequence inside the 
front cover of your manual. 

If you purchased an electronic 
version of Nature, you’ll find the 
12-letter code in the e-mail 
invoice, sent with your 
downloaded software. Store this 
e-mail in a safe place for future 
installations.

8. Click Next. 

Our installer will search for all 
compatible graphics programs 
on your computer and display 
them in a list.

9. Highlight one program (you can 
only install into one graphics 
program at a time) and click OK . 

Rerun the installer if you wish to install 
Nature into other graphics hosts. 
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Registering Nature
You must register your software to 
receive technical support and critical 
product updates. Registration also 
qualifies you for product discounts 
and upgrade pricing on future 
versions of Eye Candy.

If you purchased Nature directly from 
Alien Skin Software, you are 
automatically registered with us. You 
only need to register if you purchased 
Nature elsewhere. 

You can register online at            
http://www.alienskin.com/register. If 
you don’t have access to the World 
Wide Web, mail in the registration 
card included with your software.

User Interface
Menus: Command menus are 
accessible when you launch any filter. 
Macintosh users will see the menus in 
place of their usual menu bar. 
Windows users will see the menus at 
the top of the filter preview window.

Edit Menu: This menu allows you 
an unlimited number of Undos and 
Redos. If you experiment with the 
sliders, and find that you prefer a 
previous group of settings, simply use 
the Undo command in the Edit  
menu, or use Command + Z (Control 
+ Z on Windows machines) to back 
up as many times as necessary.

The Edit menu also allows you to 
copy, cut, paste and delete values 
from parameter fields.

Filters Menu: This menu allows you 
to switch between filters in the user 
interface. Photoshop users should 
note that they switch between filters in 
the Filters menu, the Actions, 
History, and Last Filter Used 
functions record the filter you initially 
selected.

View Menu: This menu allows you 
to zoom the preview in and out. To 
display the preview at 100% 
magnification, select Actual Pixels . 
See Keyboard Shortcuts on page13.

Help Menu: The Help menu leads 
to local documentation and online 
Web pages. Clicking Help > Filter 
accesses filter-specific 
documentation. The same assistance 
can be reached by pressing F1 
(Windows) or Help  (Macintosh).

To access a Table of Contents for the 
online help, click Help > Contents.

Common Tools
To limit redundancy in the filter 
chapters, we’ve adopted the policy of 
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documenting common tools in one 
section of the manual. Conveniently, 
you have arrived at this magical 
place. Here you’ll find explanations 
for how to use the Color Picker, the 
Color Cube and the Gradient Editor

Color Selection Tools
Color Picker

Using the Color Picker, you can select 
colors based on any reasonable color 
model (RGB, CMYK, etc.). You can 
also specify colors by hexadecimal 
values (if you’re a nerd) or use Web 
safe colors. 

To launch the Color Picker, click the 
color swatch next to any color control. 

If you don’t know how to use a color 
picker, consult your host program’s 
documentation.

Color Cube

To the right of the color swatch, you’ll 
notice a color selection tool, which 
offers the following four options.

Eye Dropper: Select the Eye 
Dropper to sample a color from 
anywhere in the preview window.

Foreground or Background 
Color: Choose either of the two.

Black or White: Choose either of 
these timeless colors.

Six Previous Colors: You can 
choose any of the six most recently 
chosen colors, which is good: you 
probably chose them for a reason.

Gradient Editor
Use the Gradient Editor dialog box to 
create custom gradients by modifying 
old ones. You can add colors to the 
gradient to blend more than two 
colors.

Let’s start with the basics. Take a long, 
hard look at the illustration below. 
Familiarize yourself with the elements 
of the gradient editor.

Smoothness Slider (A)

Use this slider to even out color and 
opacity transitions in gradients.
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Opacity Stops (B)

Opacity stops build a bridge between 
differing levels of opaqueness. The 
midpoint (diamond shaped buttons) 
and smoothness controls establish 
where and how quickly opacity 
transitions take place. Slide them 
around to get a feel for how they 
work.

Adding Opacity Stops: Click 
above the gradient bar to add an 
opacity stop. 

Modifying Opacity Stops: 

Position the cursor over any opacity 
stop and click it. Tweak the opacity 
slider.

Deleting Opacity Stops: Click 
and drag the stop off the gradient bar.

Color Stops (C)

Color stops add colors to your 
gradient and establish transitions to 
neighboring hues. The midpoint 
(diamond shaped buttons) and 
smoothness controls establish where 
and how quickly the color transition 
will take place. Slide them around to 
get a feel for how they work.

Adding Color Stops: Use color 
stops to add a new colors to your 
gradient.

To add a color stop, click below the 
gradient bar.

Editing Color Stops: Once you’ve 
added that color stop, you’ll want to 
choose a color for it.

1. Position the cursor over any color 
stop and click it.

2. Using any of the color picking 
tools, choose a color, and click 
OK . 

Deleting Color Stops: Easy. Just 
click and drag the stop off the 
gradient bar.
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The Preview Window

Slider Controls (A): Slider controls 
and radio buttons appear along the 
left side of the filter window. These 
controls perform most functions in our 
filters. Refer to the filter chapters for 
detailed slider descriptions.

Thumbnail Navigation (B):  
Click and drag the movable red box 
to move the preview to any spot in the 
selected layer.

Move, Zoom and Show 
Original (C): The Move (hand), 
Zoom (magnifying glass) and Show 
Original buttons are found above 
the preview window. 

Click the hand to enable the Move 
tool, then click and drag to move 
around the preview image.

Click the magnifying glass to enable 
the Zoom tool. Click in the preview 
window to zoom into your image; 
Command + click to zoom out (Alt + 
click for Windows users). Double-
clicking the Zoom tool at any time 
resets the preview window to 100% 
magnification.
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The Show Original button toggles 
the preview between filtered and 
unfiltered versions of your image. 
Click and hold the button to view the 
unaffected image. Release the button 
to preview the effect.

UpToDate Message Indicator 
(D): When you see this visual cue, 
you have a new message from Alien 
Skin Software. See the UpToDate 
Messages section for more details.

OK and Cancel Buttons (E): 

Clicking the OK button applies the 
filter with the current settings. Clicking 
Cancel closes the filter window 
without applying the effect.

Mouseover Help String Area 
(F): Elements in each filter have 
mouseover help text. Whenever you 
move your cursor over a user 
interface element, a short description 
appears in the bottom left corner of 
the window.

Preview Window Area (G): 

Preview the effect on your image here. 
The preview area can be resized by 
clicking and dragging any corner or 
edge of the filter window.

Progress Bar (H): The rectangle to 
the left of the magnification indicator 
displays the percentage of rendering 
completed.

Magnification Indicator (I): The 
current level of magnification is 
shown to the right of the render status 
bar at the lower right corner of the 
filter window.

Using Settings
The Settings tab in each filter 
window allows you to create, 
manage, download, share and back 
up your favorite filter recipes.

To use a setting, simply click the 
Settings  tab and highlight the 
desired setting in the list.

Saving Settings
To save a setting:

1. Adjust sliders to taste.

2. Click the Settings Tab.

3. Click the Save button.

4. Type a name for your new setting 
into the Save Setting window. 

5. Click OK .

Renaming Settings
To rename a setting:

1. Click the Settings Tab.

2. Click Manage.
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3. Highlight the setting that you 
want to rename.

4. Click Rename.

5. Type in the new name.

6. Exit the Manage Settings dialog.

Deleting Settings
To delete a setting: 

1. Click Manage .

2. Highlight the setting you wish to 
delete.

3. Click Delete .

4. Confirm that you want to delete 
the setting by clicking Yes.

Exporting Settings
When you export a setting, the plug-in 
packages the recipe in a tiny file, 
which you can share with friends. You 
can also use the export feature to 
back up settings that you can’t live 
without. To export a setting:

1. Click Manage .

2. Highlight the setting you want to 
export.

3. Click Export .

4. Navigate to the location where 
you want to store the settings file.

5. Click OK .

Importing Settings
There are two ways to extract and 
route settings to any installed Eye 
Candy 5 filter set. The first method, is 
the simplest way to import shared or 
archived settings: 

1. Find the setting that you want to 
add.

2. Double-click it.

3. Click OK .

4. You’re done.
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5. If you prefer doing things the 
hard way, use the following 
method:

6. From within the user interface, 
click the Settings tab.

7. Click Manage .

8. Click Import .

9. Navigate to the location where 
you’ve stored the setting.

10. Click Open.

11. Exit the Manage Settings dialog.

E-mailing Settings
To email a setting:

1. Click Manage .

2. Highlight the setting you wish to 
e-mail.

3. Click E-Mail.

4. If your e-mail client is compatible 
with our settings manager, a 
message will pop up like magic, 
with the setting attached. Yay!

5. Eudora, Outlook, Microsoft 
Entourage (Mac), Apple Mail and 
Outlook Express work great. 
Netscape Mail is not compatible 
with our e-mail feature. 

Resetting Settings to 
Factory Default
Every filter has a Factory Default  
setting. Clicking this setting resets the 
current filter parameters. You can also 
press the F5 (Windows) or 
Command+ R (Macintosh) key to 
reset the filter. 

That’s it for the opening section. 
We’ve designed this software to be 
both fun and easy to use. We hope 
you enjoy using the filters.
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Keyboard Shortcuts

Shortcut Function Macintosh Windows

Next Editable Text Field Tab Tab

Previous Editable Text Field Shift + Tab Shift + Tab

OK Return Return

Cancel Escape Escape

Undo Command + Z Control + Z

Redo Shift + Command + Z Control + Y

Cut Command + X Control + X

Copy Command + C Control + C

Paste Command + V Control + V

Next Filter Command +] Control +]

Previous Filter Command + [ Control + [

Zoom In Command + + Control + +

Zoom Out Command + - Control + -

Actual Pixels Option + Command + Zero Alt + Control + Zero

Restore Default Settings Command + R F5

Load Last Used Setting Command + L Ctrl + L

Save Setting Command + S Ctrl + S

Switch to Move Tool (hand) H H

Switch to Zoom Tool Z Z

Zoom In (with zoom enabled) Mouse Click Left Mouse Click

Zoom Out Option + Mouse Click Alt + Mouse Click

Zoom to Actual Pixels Double-click Zoom Tool Double-click Zoom Tool

Increase/Decrease Slider by 1 Up/Down Arrow Up/Down Arrow

Increase/Decrease Slider by 10 Shift + Up/Down Arrow Shift + Up/Down Arrow

Access Online Help Command + / or Help F1
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Chapter 2: Corona
Corona creates radiant solar flares, glowing aurora, and fills selections with 
gaseous clouds. Using one of two modes, you can create linear or wavering 
solar flares. You can also control the corona’s expansion from the selection 
edge. 

Basic Tab
Create Output In New Layer 
Below Current: Creates a layer 
below the working layer ( in Photoshop 
and Elements only) and renders the 
effect to it. This feature allows you to 
view, edit, or turn off the effect without 
affecting the original layer.

If you switch filters from within a filter 
window, the new layer feature will be 
disabled in the filter you’ve switched 
to. If you want to apply a filter in a 
new layer, make sure you start with 
the filter you plan to apply.

Create Output In New Layer Below 
Current is unavailble when recording 
actions in Photoshop. Clear this 
checkbox when recording actions.

Note: This feature cannot be used 
on a background layer.

Corona Type

• Streaky—Produces linear 
flares.
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• Turbulent—Creates chaotic, 
wavering flares.

Left: Streaky. Right: Turbulent.

Glow Radius: Controls the distance 
that the flares expand from the 
selection edge. Higher values render 
a larger corona.

Left to right: Increasing Glow Radius.

Flare Width: Controls the average 
width of the flares. Higher values yield 
wider flares.

Stretch: Controls the amount of 
flare elongation. Higher values stretch 
the shorter flares towards the edge of 
the glow radius.

Waver: Controls the random 
bending of individual flares. Higher 
values yield curvier flares.

Left to right: Increasing Waver.
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Blur: Softens the edges of the flares. 
Higher values yield softer edges.

Left to right: Increasing Blur.

Overall Opacity: Controls the 
transparency of the corona. Low 
values yield a more transparent effect. 
Underlying images remain more 
visible. Higher values reduce the 
visibility of underlying images.

Gradient Controls

For complete information on how to 
use Gradient Controls, see Gradient 
Editor on page7.

Radiate From Selection: Select 
this option to expand the effect from 
the edge of the selection, rather than 
radially from a single point inside the 
selection.

Mask Selection: Select this option 
to make the effect appear to radiate 
from the back of the selection. 

Note:  Mask Selection is disabled 
when Create Output In New 
Layer Below Current  is selected.

Left: Mask Selection disabled. The white lines text 
outlines represent the original selection. Right: Mask 
Selection enabled.

Random Seed: Controls the 
random elements of this filter. Click it 
until you get a result you like. 

Corona Offset Tab
Offset Corona Center: Select this 
option to enable the offset controls. 
Offset Corona Center is only 
available when the Radiate From 
Selection  check box is cleared.

Horizontal Offset: Shifts the 
center of the corona right or left. Zero 
produces no shift. Positive values shift 
the corona right. Negative values shift 
the corona left.

Vertical Offset: Shifts the center of 
the corona up and down. Zero 
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produces no shift. Positive values shift 
the corona up. Negative values shift 
the corona down.



18

Chapter 3: Fire
Fire simulates a wide variety of flames and flame-like effects. Using direction 
controls, you can simulate effects far beyond simple fires, like rocket exhaust. 
Color controls allow you to simulate anything from blue propane flames and 
to white hot blast furnaces.

Basic Tab
Create Output on New Layer 
Above Current: Creates a layer 
above the working layer (in Photoshop 
and Elements only) and renders the 
effect to it. 

If you switch filters from within a filter 
window, the new layer feature will be 
disabled in the filter you’ve switched 
to. If you want to apply a filter in a 
new layer, make sure you start with 
the filter you plan to apply.

Create Output In New Layer Above 
Current is unavailble when recording 
actions in Photoshop. Clear this 
checkbox when recording actions.

Fire Direction: Controls the 
direction in which the fire column 

travels. Click and drag within the 
control box to change the direction, 
or enter a value between 0 and 360 
degrees.

Column Length: Controls the 
length of the fire column. 
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Flame Width: Controls the average 
width of the smaller flames forming 
the fire column.

Left to right: Increasing Flame Width. 

Expansion: Controls the growth of 
the column into a V-shape. High 
values widen the V.

Left to right: Increasing Expansion.

Waver: Controls the amount of 
meandering in the fire column. 

Higher values increase the twisting. 
Low values render fire that travels 
along a linear path. 

Turbulence: Adds twisting details to 
the tips of the flame. High values 
resemble flickering.

Left to right: Increasing Turbulence.

Flame Intensity: Brightens the 
inside color to simulate hotter flames. 
Higher values appear “white hot.”

Left to right: Increasing Flame Intensity.
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Soften Edges: Blurs the edges of 
the flames and elevates the fire above 
the selection. High values soften the 
flame more.

Left to right: Softened edges.

Start From Bottom: Select this 
option to cover the entire selection 
with fire. 

Mask Selection: Select this option 
to make the effect appear to rise from 
the back of the selection. 

Random Seed: Controls the 
random elements of this filter. Click it 
until you get a result you like.

Colors Tab
Natural Flame Colors: Select this 
option to simulate common fire 
tinting, like a match or campfire. 
Clear Natural Flame Colors  to 
enable the gradient editor.

For more information on using 
gradients, see Gradient Editor on 
page7.
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Chapter 4: Drip
Drip simulates liquid trickling from the bottom of a selection and, optionally, 
melts the original selection. Drips flow from the bottom of the selection like 
paint dribbles. Image features stretch along the path of the drips. By tweaking 
melt features, you can liquefy the entire selection. 

Drip Tab
Drip Length: Controls the average 
distance that drips run from the 
bottom of the selection.

Width: Controls the average 
thickness of each drip. High values 
reduce the number of drips in your 
selection.

Density: Controls the number of 
drips falling from your selection. High 
values add more drips.

Left to right: Increasing Density.
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Taper: Thins the area between the 
bottom of the selection and the drip’s 
teardrop end. Low values look like 
liquid running down a wall. High 
values look like drops falling from the 
bottom of the selection.

Left to right: Increasing Taper.

Dribble: Controls the irregularity of 
the drip edges. High values make 

uneven edges and separate the drip 
from the selection.

Left to right: Increasing Dribble.

Random Seed: Controls the 
random elements of this filter. Click it 
until you get a result you like. 
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Melt Tab
Melt Length: Controls how much 
the entire selection is stretched 
downwards in wavy distortions.

Left to right: Increasing Melt Length.

Ripple Width: Controls the 
average width of the distortions in the 
selection. If you go too small, you’ll 
get speckles. In small selections, a 
value too large might result in little 
visible distortion.

Pooling: Controls how much the 
affected area sags toward the bottom 

of the selection. High values 
compress the selection downward.

Left to Right: Increased pooling.

Lighting Tab
Direction: Controls the direction 
from which the light falls on the 
surface. Click and drag within the 
lighting control box to change the 
direction, or enter a value between 0 
and 360 degrees.

Inclination: Controls the angle 
formed by the light and the page. 
Click and drag within the lighting 
control box to change the inclination, 
or enter a value between 0 and 90 
degrees.

Highlight Brightness: Controls 
the intensity of the shiny highlights 
appearing on the surface.

Highlight Size: Controls the size of 
the shiny highlights on areas facing 
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the light; higher values yield larger 
highlights.

Highlight Color: Choose any color 
for the shiny highlights.

Shadow Strength: Controls the 
shadow darkness. Higher values 
render darker shadows.

Shadow Color: Choose any color 
for the shadows. 

Lighting Coverage: Controls how 
far the shiny highlights climb up the 
dribbles.

Left to right: Increasing Lighting Coverage adds 
three dimensionality to the drips.
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Chapter 5: Icicles
Icicles renders dripping ice from any selection. You can specify the length, 
width, pointedness and color of the icicles. You can also manipulate opacity 
and refraction to reveal images under the ice. As you might imagine, Icicles 
compliments Snow Drift nicely.

Basic Tab
Maximum Length: Specifies the 
maximum length to which icicles can 
grow. 

Width: Specifies the average width 
of icicles. 

Note: Extremely wide icicles which fill 
the breadth of a selection limit the 
effectiveness of the Density  slider.

Density: Controls the number of 
icicles rendered in the selection. 
Higher values insert more icicles, 
packing them together closely. 

Pointedness: Sharpens the tips of 
icicles. 

Icicle Regularity: Randomizes the 
length, width and spacing of icicles. 

Higher values increase the uniformity 
of these three features.

Left to right: Increasing Icicle Regularity.   

Ice Height: Controls how far the ice 
grows upward from the bottom of the 
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selection. Larger values cover more of 
the selection with a solid sheet of ice.

Left to right: Increasing Ice Height.

Ice on Entire Selection: Selecting 
this option covers the inside of the 
selection with a sheet of ice.

Ice Color: Selects the color the ice is 
tinted. The higher the Opacity slider, 
the stronger this color appears. For 
more information on selecting colors, 
see Color Selection Tools on page7.

Opacity: Low values allow 
underlying images to shine though. 
High values obscure underlying 
images. Extremely high values render 
solid, dripping goo, like wax. 

Refraction: Roughens the surface of 
the ice and underlying images. Less 
refraction creates a smoother surface, 
allowing a clearer view of objects 
under the ice. High values create a 

rough surface, mangling images 
beneath the ice.

Left to right: Ice on entire selection is enabled on 
both stoplights. Refraction is enhanced in the right 
frame.

Random Seed: Controls the 
random elements of this filter. Click it 
until you get a result you like.

Lighting Tab
Direction: Controls the direction 
from which the light falls on the ice. 
Click and drag within the lighting 
control box to change the direction, 
or enter a value between 0 and 360 
degrees.

Inclination: Controls the angle 
formed by the light and the page. 
Click and drag within the lighting 
control box to change the inclination, 
or enter a value between 0 and 90 
degrees.
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Highlight Brightness: Controls 
the intensity of the shiny highlights 
appearing on the ice surface.

Highlight Size: Controls the size of 
the shiny highlights on areas facing 
the light; higher values yield larger 
highlights.

Highlight Color: Choose any color 
for the shiny highlights. 

Shadow Strength: Controls the 
shadow darkness. Higher values 
render darker shadows. 

Shadow Color: Choose any color 
for the shadows. For more 
information on color selection, 
see Color Selection Tools on page7.
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Chapter 6: Ripples
Ripples’ three modes create anything from perfect concentric waves to the 
random surface waves of a pond on a windy day. You can add reflection 
maps to create a shiny surface and use refraction controls to make images 
look like they are underwater. You can use the Time control to make GIF 
animations.

Basic Tab
Ripple Generator: Choose one of 
three modes:

• Raindrops—Creates circular 
waves emanating from distinct 
points. Adding more than one 
raindrop creates overlapping rip-
ples.

Raindrops mode.
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• Expand from Selection—
Creates concentric waves radiat-
ing from selection edges.

Expand from Selection mode

• None—Covers the entire selec-
tion with random waves.

Random waves in None mode.

Number of Raindrops: Selects 
the number of rain impact points in 
your selection. 

Ripple Wavelength: Controls the 
average distance between wave 
crests.

Time: Chooses a moment in the 
timeline of ripple formation and 
dissipation. Early in the timeline, 
wavelengths are small and radiate 
directly from the selection or 
raindrop. In the latter stages of wave 
development, the ripples move away 
from the selection and dissipate. 

Random Wave Amplitude: Adds 
random ripples to the surface of your 
selection. Higher values create taller 
waves.

Left to right: Increasing Random Wave Amplitude. 

Random Wave Wavelength: 
Controls the average spacing 
between random wave crests. 
Extremely low values speckle the 
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surface with tiny ripples. High values 
create large swells.

Left to right: Increasing Random Wave Wavelength.

Note: This value is linked to Ripple 
Wavelength .

Refraction: Controls the strength of 
distortion in opaque selections. 
Refracted selections look like they are 
under water. To be visible, 
Refraction  must be used in an 
opaque layer. 

Left to right: Increasing Refraction.

Draw Outside Selection: Select 
this option to fill the entire layer with 
ripples.

Random Seed: Controls the 
random elements of this filter. Click it 
until you get a result you like.

Lighting Tab
Lighting Controls

Direction: Controls the direction 
from which the light falls on the 
surface. Click and drag within the 
lighting control box to change the 
direction, or enter a value between 0 
and 360 degrees.

Inclination: Controls the angle 
formed by the light and the page. 
Click and drag within the lighting 
control box to change the inclination, 
or enter a value between 0 and 90 
degrees.



31

Highlight Brightness: Controls 
the intensity of the shiny highlights 
appearing on the surface.

Highlight Size: Controls the size of 
the shiny highlights on areas facing 
the light; higher values yield larger 
highlights.

Highlight Color: Choose any color 
for the shiny highlights.

Reflection Map Controls

None: Choose this option if you do 
not want an image reflected on the 
surface of your liquid.

Select From File: Selects a 
reflection map file. Reflection maps 
color the wave contours to simulate a 
shiny liquid surface. 

Reflection Strength: Controls the 
opacity of the reflection map. Higher 
values yield a brighter, more reflective 
surface. Lower values allow more of 
the original selection to shine 
through.
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Chapter 7: Rust
From crusty iron oxide to aluminum scaling, rust recreates virtually any severe 
metallic corrosion. You can control the size and color of rust spots, the size 
and sharpness of surface details and the density of coverage.

Basic Tab
Create Output in Layer Above 
Current: Creates a layer above the 
working layer (in Photoshop and 
Elements only) and renders the effect 
to it. This feature allows you to view, 
edit, or turn off the effect without 
affecting the original layer.

If you switch filters from within a filter 
window, the new layer feature will be 
disabled in the filter you’ve switched 
to. If you want to apply a filter in a 
new layer, make sure you start with 
the filter you plan to apply.

Create Output In New Layer Above 
Current is unavailble when recording 
actions in Photoshop. Clear this 
checkbox when recording actions.

Feature Size: Zooms the rust 
patches in and out. High values yield 
a close up view; the spots grow larger 
and the spacing between each patch 
increases. Surface features, such as 
flaking, become more larger and 
more detailed.
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Left to right: Increasing Feature Size.

Coverage: High values fill empty 
space with more rust patches.

Left to right: Increasing Coverage.

Edge Roughness: Adds a jagged 
edge to spots. Higher values render 
an uneven edge. Low values make 
smooth edges.

Soften Spots: Creates a transition 
of opacity in spots. Low values create 
patches with defined edges and 
consistent surface detail. High values 

yield a transition from crusty inner rust 
to translucent surface rust.

Left to right: Increased softening with added water 
streaks.

Texture Variation: Adds contrast 
and detail to the flaky surface 
features.

Rust Color: Selects the dominant 
rust color. 
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Draw Water Streaks: Select this 
option to smear rust downward from 
the main spots. 

Streak Length: Increases the 
distance that streaks are smeared 
from the patches. 

Streak Opacity: Controls the 
darkness of the smears. The 
opaqueness tails off toward the end 
of the streaks.

Seamless Tile: Select this box to 
create a repeatable pattern with no 
seams.

Note: Selecting Seamless Tile 
disables streak controls.

Random Seed: Controls the 
random elements of this filter. Click it 
until you get a result you like.
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Chapter 8: Smoke
Using two modes, Smoke simulates anything from pyroclastic eruptions to 
gentle wisps emerging from the end of a gun barrel. You can control the 
direction of the smoke, its color, how high it rises and much more.

Basic Tab
Create Output on New Layer 
Above Current: Creates a layer 
above the working layer (in Photoshop 
and Elements only) and renders the 
effect to it. This feature allows you to 
view, edit, or turn off the effect without 
affecting the original layer.

If you switch filters from within a filter 
window, the new layer feature will be 
disabled in the filter you’ve switched 
to. If you want to apply a filter in a 
new layer, make sure you start with 
the filter you plan to apply.

Create Output In New Layer Above 
Current is unavailble when recording 
actions in Photoshop. Clear this 
checkbox when recording actions.

Smoke Type

• Wispy—Creates tendrils of 
smoke, like a cigarette in an ash-
tray.

• Billowing—Renders puffy 
clouds—like the emissions from 
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a smokestack in Elizabeth, New 
Jersey or a forest fire.

Left: Wispy. Right: Billowing.

Smoke Direction: Controls the 
direction in which the smoke column 
travels. Click and drag within the 
control box to change the direction, 
or enter a value between 0 and 360 
degrees.

Column Length: Controls the 
length of the smoke column. 

Puff Size: In Wispy mode, Puff 
Size controls the average width of 
the tendrils forming the smoke 

column. Larger values yield wider 
individual wisps.

Left to right: Increasing Wispy Puff Size.

In Billowing mode, Puff Size 
controls the average size of the puffy 
clouds that form the smoke.

Left to right: Increasing Billowing Puff Size.

Expansion: Controls the growth of 
the column into a V-shape. High 
values widen the V.
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Waver: Controls the amount of 
meandering in the smoke column. 
Higher values increase the twisting. 
Low values render smoke that travels 
along a linear path. 

Roughness: Controls the 
smoothness of the smoke. High 
values render turbulent smoke.

Left to right: Increasing Roughness.

Overall Opacity: Controls the 
transparency of the entire smoke 
column. High values make a more 
visible smoke column.

Layered Smoke: Select this option 
to render a second layer of smoke in 
front of the original.

Left: Non-layered. Right: Layered Smoke selected.

Start From Bottom: Select this 
option to cover the entire selection 
with smoke. 

Mask Selection: Select this option 
to make the effect appear to rise from 
the back of the selection. 

Random Seed: Controls the 
random elements of this filter. Click it 
until you get a result you like.

Color and Lighting Tab
Smoke Color: Tints the smoke any 
color. 

Soot: Darkens the edges of the 
smoke and adds contrast to the effect.

Light Direction: Controls the 
direction from which the light falls on 
the smoke. Click and drag within the 
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lighting control box to change the 
direction, or enter a value between 
0and 360 degrees.

Light Strength: Boosts the intensity 
of the light source. It’s like increasing 
the wattage of a light bulb.

Light Color: Tints the light source. 
You can make smoke in the red light 
district. 
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Chapter 9: Snow Drift
Snow Drift adds piles of snow to horizontal sections of a selection. You can 
pile snow on the top or bottom of the selection. You can also control the 
thickness and lumpiness of the snow. Optionally, you can dust the surfaces of 
your entire selection, or entire image, with light snow. By adding more dust to 
bright spots you can simulate snow piling on rooftops, trees, or any other 
bright surface. 

Basic Tab
Create Output on New Layer 
Above Current: Creates a layer 
above the working layer (in Photoshop 
and Elements only) and renders the 
effect to it.

If you switch filters from within a filter 
window, the new layer feature will be 
disabled in the filter you’ve switched 
to. If you want to apply a filter in a 
new layer, make sure you start with 
the filter you plan to apply.

Create Output In New Layer Above 
Current is unavailble when recording 
actions in Photoshop. Clear this 
checkbox when recording actions.

Drift Height: Specifies the 
maximum drift height. Higher values 
make taller piles. 

Note:  The selection edge limits the 
maximum attainable snow height. 

Clumping: Controls the lumpiness 
of the snow. Higher values create 
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more lumps of increasingly random 
size and height.

Top to bottom: Increased Clumping.

Surface Roughness: Adds a rough 
texture to the surface. Low values 
render a shiny surface. High values 
yield a textured surface, like snow that 
has melted and refrozen.

Droop: Expands the bottom edge of 
the snow below the selection. Higher 

values increase the distance that the 
snow sags beneath the selection.

Top to bottom: Increasing Droop.

Start Snow Drift from Selection 
Bottom: Select this option to place 
the snow on the lower, horizontal 
areas the selection.

Dust on All Features: Covers the 
entire selection with a uniform dusting 
of light snow. Higher values increase 
the dust density.

Dust on Bright Features: Places 
a thicker coating of dust on bright 
areas within your selection. Higher 
values amplify the effect.

Note:  Dust on All Features and 
Dust on Bright Features are 
disabled when Create Output In 
New Layer Above Current  is 
selected.
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Bright Features Threshold: 
Adjusts the level of brightness that the 
filter recognizes as “bright enough” to 
receive additional dusting. Low values 
specify that only the brightest features 
get extra dust. High values extend the 
added dusting into darker areas.

Random Seed: Controls the 
random elements of this filter. Click it 
until you get a result you like.

Lighting Tab
Light Direction: Controls the 
direction from which the light falls on 
the snow surface. Click and drag 
within the lighting control box to 
change the direction, or enter a value 
between 0 and 360 degrees.

Shadow Strength: Controls the 
shadow darkness. Higher values 
render darker shadows. 

Shadow Color: Choose any color 
for the shadows. For more 
information on selecting colors, 
see Color Selection Tools on page7.

Tip
When adding dust to bright surfaces 
in your selection, use an extremely 
low Dust on All Features  amount. 
A value of zero typically works best.
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Chapter 10: Squint
Squint imitates the blurring that might result from bad vision or a shaky 
cameraman. Squint also creates bright light streaks and kaleidoscopic effects 
like you might see from oncoming traffic in a rainstorm.

Basic Tab
Ghost Radius: Controls the 
expansion of the blur. Low values 
render a thin, visible halo; the original 
image details, though blurred, are still 
visible. High values obscure the 

original image. A zero value results in 
no ghosting.

Left to right: Increasing Ghost Radius.
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Ghost Segments: Breaks the halo 
into smaller pieces. Higher values 
yield more pieces.

Left to right: The subtle effect of adding ghost seg-
ments.

Ghost Rotation: Controls the 
direction in which the segments travel. 
Click and drag within the control box 
to change the direction, or enter a 
value between 0 and 360 degrees.

Draw Light Streaks: Select this 
option to add rays of light that burst 
from bright areas in the image.

Streak Brightness: Enhances the 
whiteness of the streaks, making them 
appear brighter.

Streak Opacity: Controls the 
visibility of the light streaks. Low 
values render imperceptible rays. 
High values create visible streaks and 
smear colors like a motion trail.

Streak Selection Threshold: 
Adjusts the level of brightness that the 
filter recognizes as “bright enough” to 
radiate streaks of light. Low values 
allow virtually any area to emit 
streaks. High values allow only the 
brightest areas to do so. 

Left to right: Increasing Streak Selection Threshold. 

Streak Length: Specifies the 
average length of the streaks.

Number of Streaks: Controls the 
density of streak placement. High 
values add more radial streaks, which 
eventually overlap to render a brilliant 
glow.

Streak Variation: Increasingly 
randomizes the direction in which 
individual streaks point. 

Streak Rotation: Controls the 
direction of the streaks. Click and 
drag within the control box to change 
the direction, or enter a value 
between 0 and 360 degrees.
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Random Seed: Controls the 
random elements of this filter. Click it 
until you get a result you like.
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Chapter 11: Water Drops
Water Drops creates a wide variety of liquid shapes: spheres, spurts, spills, 
spots and more. You can select the color of the drops, make them pool 
together and distort underlying images as if they had been rained on.

Basic Tab
Drop Size: Controls the size of the 
liquid blobs. High values yield fewer, 
larger drops. Low values splatter the 
selection with small drops.

Coverage: Controls the percentage 
of the selection covered with liquid. 

You can select any value between 1 
and 100 percent.

Left to right: Increasing Coverage.

Clumping: Creates gravity between 
the drops. At higher values the liquid 
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pools together, forming large 
irregularly shaped blobs.

Left to right: Increasing Clumping.

Focus: Sharpens the edges of drops 
and boosts the brightness of the liquid 
color.

Left to right: Increasing Focus.

Refraction: Controls the amount 
that the selection is warped by the 

water drops. Higher values increase 
the distortion. 

Opacity: Controls the transparency 
of the liquid. High values obscure any 
underlying images. 

Tinting: Chooses the amount of 
Liquid Color  revealed by light 
passing through the blobs. Low values 
show less of the liquid color. 

Liquid Color: Choose any color for 
your water drops. For more 
information on selecting colors, 
see Color Selection Tools on page7.

Lighting Controls

Direction: Controls the direction 
from which the light falls on the 
drops. Click and drag within the 
lighting control box to change the 
direction, or enter a value between 0 
and 360 degrees.

Inclination: Controls the angle 
formed by the light and the page. 
Click and drag within the lighting 
control box to change the inclination, 
or enter a value between 0 and 90 
degrees.

Highlight Brightness: Controls 
the intensity of the shiny highlights 
appearing on the drops.

Highlight Size: Controls the size of 
the shiny highlights on areas facing 
the light; higher values yield larger 
highlights.

Highlight Color: Choose any color 
for the shiny highlights. For more 
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information on selecting colors, 
see Color Selection Tools on page7.

Random Seed: Controls the 
random elements of this filter. Click it 
until you get a result you like.
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Chapter 12: Troubleshooting
We’ve documented the most 
commonly-asked tech support 
questions here. A regularly updated 
troubleshooting guide can be found 
in the Support section of our Web site. 
If you get really stuck, send E-mail to 
support@alienskin.com. Include in 
the E-mail your 12-letter registration 
code, whether you are using Mac or 
Windows, and your graphics host 
program (Photoshop, Paint Shop Pro, 
etc.).

This chapter covers the following 
troubleshooting issues:

• Installation Problems

• Performance Issues

• Error Messages

Installation Problems
Problem

The installer won't accept my 12-letter 
registration code, or I can't find my 
code. 

Solution

Lost registration code: The 
product registration code (serial 
number) is a 12-letter code located in 
one of the following three places:

• Your user manual (physical ver-
sion). 

• On the CD jewel case (physical 
version). 

• On the download page and in 
an email invoice (electronic ver-
sion).

If you've registered the software with 
us (by purchasing directly from us, 
registering online or sending in a 
registration card), we'll have the code 
in our database.

If you didn't register with us, contact 
us at support@alienskin.com to 
receive a new registration code. 

If you have the code: Make sure 
that you are entering the 12-letter 
code and other registration fields 
correctly. The Name field must 
contain at least three characters. 

Make sure that you are using a valid 
code. Product registration codes are 
not interchangeable. For example, an 
Eye Candy 4000 code will not work 
with any other product. You will need 
to use the code that you received 
when you purchased the software. 
This 12-letter code can be found on 
the web page from which you 
downloaded the software, in an email 
invoice you received while 
downloading the product or on a 
sticker inside the front cover of the 
manual.

Problem

When I try to install, I get an error 
dialog saying that I don’t have 
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privileges or permission to install the 
software.

Solution

The installer, like most installation 
programs, needs to write files to 
secure folders on your computer. If 
you use OS X, Windows 2000 or 
Windows XP, you must have 
administrator privileges. For 
information on configuring your user 
account for these privileges, see your 
system administrator or your 
operating system manual.

Problem

After installing the plug-ins and 
starting the graphics host program, 
the filters do not appear in the Filter 
or plug-in menu.

Solution

The filters were not installed in your 
graphics program’s plug-in folder. 
Find out which folder your host 
program uses for plug-ins. With 
Photoshop, you can determine this by 
going to Edit > Preferences > 
Plug-ins. Then, install the filters 
again, making sure you select the 
proper plug-in folder. 

Also, remember that after installing 
new filters, you must restart your 
graphics host for the plug-ins to 
become available. With other host 
programs, consult your user manual 
for more information about where 
plug-ins need to be installed and how 
to access them.

Problem

My software doesn’t work with a 
graphics program that claims to use 
Photoshop plug-ins.

Solution

Some host programs claim to work 
with all Photoshop plug-ins without 
testing thoroughly or strictly following 
the Photoshop plug-in standard. If 
you’d like to use our software with a 
host not  listed in this manual, please 
visit our Web site for the latest list of 
compatible hosts.

Problem

How do I uninstall my software?

Macintosh Users: Find the Nature 
folder in your graphics program’s 
plug-in folder and delete it. Also 
delete the 
/Users/<user name>/Library/
Application Support/Alien 
Skin/Nature  folder.

Windows Users: Run Add/
Remove Programs from your 
Windows Control Panel. Select 
Nature from the program list and 
click the Add/Remove button. This 
will remove the program and most of 
its components. To remove your 
settings, navigate to the 
/Documents and Settings/
<user name>/Application 
Data/Alien Skin/Eye Candy 5 
Nature folder.
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Performance Issues
Problem

Some or all of the filters appear 
grayed out in the Filter menu.

Solution

Grayed-out filters in the Filter menu 
occur if you are in certain color 
modes (such as CMYK, Lab or 
Bitmap) that won’t allow a specific 
filter to work properly.

Problem

I get a message that my software ran 
out of memory while rendering the 
preview.

Solution

There are a few things you can do to 
free up more memory. In Photoshop, 
the history palette and other features 
take up a lot of memory. You can free 
this memory by selecting Edit > 
Purge > All. 

To free up even more memory in 
Photoshop, select Edit > 
Preferences > Memory & 
Image Cache . Then, increase the 
Maximum Used value. 

If you routinely work with huge 
images, we recommend that you have 
ten times as much physical RAM as 
the image size in memory.

Problem

The preview seems broken. It only 
shows the checkerboard pattern.

Solution

Sometimes the preview begins in a 
transparent part of a layer. Click an 
opaque area of your selection in the 
navigation thumbnail.

Problem

A filter makes the graphics program 
or the entire computer crash or freeze 
up.

Solution 

Sometimes freezes or crashes occur 
when your computer runs out of 
available memory. If you are using 
Photoshop, you can sometimes free 
up large amounts of memory by 
selecting Edit > Purge > All .

Also, make sure that your computer 
system meets the minimum 
requirements to run our software. 
Shut down other programs before you 
run your image editing program, as 
there might be a conflict between 
another program and our software. If 
you notice such a conflict, we will love 
you very much if you try to identify the 
problem program and inform us of 
the conflict at 
support@alienskin.com .

Problem

I can’t switch between filters inside the 
Eye Candy user interface. 

Solution

The feature only works in Photoshop 
CS and Elements. Other hosts don’t 
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support the necessary parts of the 
Photoshop plug-in specification.

Also, if you switch filters using the 
menu on the filter dialog, the new 
layer feature will be disabled in the 

filter you’ve switched to. If you want to 
apply a filter in a new layer, make 
sure you start with the filter you plan 
to apply.

Error Messages

Error Message User Remedy

This host application does not support 
enough of the Photoshop filter specifi-
cation for this filter to run.

Sorry! Your host graphics program is incompatible with our 
software. Consult the list of compatible host programs in the 
Host Requirements section of the Getting Started chapter.

This filter requires editable transpar-
ency. Please turn OFF Preserve Trans-
parency in the Layer palette.

In the Layers tab, deselect the Lock Transparent Pixels 
button.

The filter ran out of available memory 
while rendering the preview image.

The history palette and other features take up a lot of mem-
ory. In Photoshop, you can free up this memory by selecting 
Edit > Purge > All.

You may not have enough physical memory (RAM) to handle 
the image that you’re working with.

Macintosh users only: This filter 
only runs on Mac OS X 10.2 or later.

Check the operating system requirements for this software in 
your user manual. Nature only works with Mac OS X 10.2 or 
later.


